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1. Overview
1.1 What is AnhswerSheetD1Y ?

AnswerSheetDIY is an application that reads the presence or absence of marks from bubble
answer sheet images and can save the result as CSV or TSV format data. You can use the data
for some spreadsheet applications.

When you want to do quizzes in some lesson or want to take a questionnaire, you can easily
get the result without special card readers or special kind of sheets.

AnswerSheetDIY provides only two functions: (1) predefining the information on the bubble
positions of the document, and (2) judging the presence or absence of the mark on the bubbles
and outputting it as data (see 1.2).

Therefore, you have to prepare the original of the answer sheet by yourself.

A device dedicated to bubble answer sheets is unnecessary, but a printer and a scanner with
an automatic document feeder are necessary. Recent scanners have surprisingly good
performance, so even relatively inexpensive mobile scanners are good enough.

1.2 What AnswerSheetDIY supports?

AnswerSheetDIY does not support everything from creation to summarization of quizzes or
questionnaires. I will explain the parts that AnswerSheetDIY supports and does not do in the
flow from creation of answer sheet to summation.

(1) Making the original of the answer sheet
It is not supported by AnswerSheetDIY.
Answer sheets can be created in relatively free formats. You can use general word
processors and graphics editors to create. Even handwriting is acceptable. However, as
described later, marks for positioning is indispensable. It is also necessary to know the
size of bubbles and available answer styles. Refer to Chapter 2.

(2) Printing, distributing, and filling in
It is not supported by AnswerSheetDIY.
Answer sheets are printed on ordinary printer paper or copied and distributed. Use
pencils or ordinary pens to fill bubbles.

(3) Specifying the position of bubbles
Load the document of an answer sheet into AnswerSheetDIY as image data such as PDF
or JPEG, and specify the position of bubbles. In AnswerSheetDIY, specify not only the
position of bubbles but also attributes such as whether to answer only one choice or
multiple choices. After specifying the position, save the information in a file.

(4) Scanning of answer sheets



It is not supported by AnswerSheetDIY.
Scan the collected answer sheet and load as an image format of PDEF, JPEG, etc. into the

computer. The images are gray (monochrome), resolution of about 200 dpi is
recommended.

(5) Recognition of marks

Based on the information on the mark position created in (3) above, the images scanned

in (4) are read in to determine the presence or absence of marks. The result can be saved
as CSV or TSV data file.

The only thing to fetch here is simply the information "where they were marked." We do
not score quizzes or summarize questionnaires. Also, it does not read in sentences,
numbers, symbols, nor signatures, etc.

(6) Scoring
It is not supported by AnswerSheetDIY.

Since the result of reading answer sheets is text data that can be used for spreadsheet,
scoring will be relatively easy (I personally use AWK which is a scripting language).
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Fig.1-1 Overview of AnswerSheetDIY

As mentioned above, AnswerSheetDIY supports only steps (3) and (5).

Commercial answer sheet reading systems have various functions added, such as
summarization of questionnaire results, scoring function of quizzes, output of graphs and
achievement management of individual students, but they are not handled by AnswerSheetDIY.
Please deal them with script language, spreadsheet, etc. (Do It Yourself!).
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2. Formats of answer sheets

2.1 The size of sheet and the positioning marks

Although there is no clear limit to the size of answer sheets that can be handled,
AnswerSheetDIY is developed assuming to use A4 or B5 size answer sheets. Smaller or larger
size sheets are also available, but considering automatic scanning with a scanner, you can
actually think of it as a range up to A4 size.

Answer sheets can be either portrait or landscape.

After reading answer sheets with a scanner and saving their image data, detect marks with
AnswerSheetDIY. However, some answer sheets might have been turned upside down or others
might have been read with a slight inclination with the scanner. To correct them automatically,
it is necessary to place four square marks on each sheet. They are called positioning marks. If
the positioning marks can not be recognized correctly, the information of the sheet can not be
read. Therefore, careful attention must be paid to setting the marks.

Regardless of whether the paper is vertically or horizontally long, the positioning mark at

the upper left corner is a larger square, the other three marks are smaller squares and have the
same size.

Portrait Landscap
Bigger than others ------ - B | | '
S The shorter side
Small | Rt v e of the paper
Each size is the same | "~ ... o E - Ia
mE H Ia
; , a=0.3XS
a

Fig.2-1 Positioning marks

The size of the square on the top left corner is about 8 mm and the small ones are about 6
to 7 mm. The size is not strictly determined, but if it is too small, it may be confused with
other characters on the paper.

When reading answer sheets with a scanner and creating images, the positioning marks
must not be in contact with the edge of the image. Margins must be left around the marks. Do
not overlap or touch other characters or figures with them.

Positioning marks must be placed at the four corners of the paper and in square areas that
have about 30% of the short side of the paper as one side. Within these area, there must not be
other filled areas just like the positioning marks. Regular letters are ignored even in this area,
but, if possible, please avoid large symbols with filled area such as %, e, or emojis.

Bubbles for choices can be placed only inside the rectangle formed by connecting the centers
of the positioning marks.

2.2 Bubbles for choices

It seems that an ellipse of about 4 mm X 2 mm is common for the frame of a bubble. But it
could be a circle, because a filled area of about 2 mm X 2 mm can be recognized as a mark. If
you are creating the original of sheets with a word processor, you can draw ellipses (Fig.2-2(a))
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if you can draw figures, or you can use capital letter "O"s or zeros (Fig.2-2(b), (c)). You can also
arrange them in the vertical direction (Fig.2-2(d), (e)).

QL: Q2: Q3:

1 2 3 4 8 1 2 3 4 6 1 2 3 4 6
(a) Drawing of (b) Zeros in Gill (c) "O"s in Avenir Next
ellipses Sans Light Condensed Ultra-light

Q4 0
1 1
2 2
5| (d) A text box rotated by 90° 3
4 that uses "O"s in Avenir 4 (e) A Text box with “O"s
5 Next Condensed Ultra-light ° (Unicode U+25EF)

Fig.2-2 Bubbles for choices

Since AnswerSheetDIY examines the thickness within a certain area of the mark, there is a
possibility that a mere bold line drawn can not be recognized. On the other hand, if the frame
of a bubble itself is a thick black line, the possibility of misrecognition will increase, so I
recommend drawing bubbles with a thin line as in the examples above.

With AnswerSheetDIY, never place a letter in a bubble. Being different from dedicated mark
sheets, AnswerSheetDIY may fail to recognize them.

Marks may sometimes protrude from the frame. To avoid misrecognition, you should avoid
making the bubbles closer together.

Even if the bubbles are arranged irregularly or placed in the midst of sentences, there is no
problem in positioning. For example, if you place a bubble just before each choice as follows,
you do not have to move the line of sight between the choices and the bubbles to be marked,
so you can reduce the possibility of miscopies.

Question#5  How often do you see movies online?
A. () Extremely often B.( ) Very often

C. () Moderately often D.( ) Slightly often E.( ) Not at all often

However, if you leave the answer space separate from the question, you can easily change
only the question to another content later. Also, the operation to specify the position of
bubbles described in Chapter 3 is easier if they are arranged at equal intervals in the horizontal
and vertical direction. Especially, when there are many reply spaces, you can drastically reduce
the labor of work.

If you see "blackness" more than a certain degree by human eyes, AnswerSheetDIY can
recognize marks even drawn with a ballpoint pen or a felt pen (Commercial dedicated readers
use light of a specific wavelength to recognize only marks drawn by graphite pencils). For
graphite pencils, please use the grade HB (#2) or the thicker. For harder pencils such as 2H
(#4), the recognition rate decreases significantly, so please do not use them.



2.3 Kinds of choices
This section shows the kinds and formats of choices available in AnswerSheetDIY.

(1) Single-select
This is a form that selects and replies only one from the choices. For example, it is used
when choosing the most appropriate one from about five choices or letting you select
Yes / No.

(2) Multi-select

This is used to select any number of applicable choices from a set of choices.

(3) Confirmation
This is a single reply format to mark only if applicable. This type would be a variation of
format (1) or (2) with only one bubble.

(4) Grouping
This is a type that contains some choices and they constructs a meaningful reply such as

an ID number or date. In addition to letting you select multiple digits, you can combine
alphabets and so on.

Reply bubbles are associated with numbers or alphabets, such as 1, 2, 3, .... The fact that a
certain bubble is filled is represented by the corresponding number, alphabet, and so on. The
styles shown in Table 2-1 are prepared for numbering.

Table 2-1 Styles of numbering

Numbering Max  Multiple Notes
1,23, .. 100 v
0,1,23,.. 100 v Starts from "0".
A B,C,.. 26 v
Yes, No 2
Yes, No, N/A 3 "N/A" is "not applicable”.
0,12..9ABC¢C.. 36 v Digits and alphabets starting from "0".
-01,2,..9ABC,.. 37 The first is a minus sign.
-101,2,..9ABC.. 38 For mathematical use.
1,2,3,4,5,6,7,89,0 10 "0"is at the last.
_AB ..Z- 28 The first is a space, the last is a minus.
7,14,9,.. 46 v Japanese Katakana characters.

2.4 An example of an answer sheet
Here is an example of a bubble answer sheet. This is a PDF created from a document of
Pages (it is shrunk to paste into this document). In this example, the questions and the answer
spaces are put together on the same form, but, of course, you can make a sheet that only
answer spaces are arranged.
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S Do not write anything around the marks "=" at the corners of the paper, as they are
Urvey needed for recognition. Please do not fold or stain the paper.

Q1: Please select one answer that best applies to each of the questions below and fill in the

corresponding bubble in the answer space.
(1) On which day would you like to have a meeting?

A.Monday, B.Tuesday, C.Wednesday, D.Thursday, E. Friday
(2) What is the preferred way of contact regarding the meeting?

A.Phone, B.Individual mail, C. Mailing list,

D. Bulletin board, E. Groupware 1

(3) Do you know what cloud services are?
A.I'musingit, B.My colleagueis usingit, (2)| alslclplUe

C. | know the overview, D.|know the name,

E. | don't know at all. (3) alUscUple

Q2: Please select one answer that best applies to each of the questions below and fill in the
corresponding bubble.

(1) How many hours are you watching TV a day in average? (online video is excluded)
A. O Lessthan 1hour, B.() 1-2hours, €. 2-3hours,
D. ) 3-4hours, E.C)4-5hours, F.(O)5-6hours, G.) More than 6 hours

(2) Are you subscribing to the newspaper?
YES No

(3) Are you interested in energy conservation?
YES No N/A

Q3: Please select any number of keywords related to the field of interest and fill in O.
(A)UJVR, (B) /AR, (C) UloT, (D)) Programming, (E)' /Al (F) ' Web Apps,

(G) L) Smart Phones, (H) '’ Robots, (I) '\ Embedded Systems,  (J) |/ Games,
(K) ' SNS, (L) U Image Processing, (M) ' voice recognition, (N) L Security

o 0 o o 0 o Q4: Those who keeping pets, please fill in the
1 1 1 1 1 1 bubble.
2 2 2 2 2 2
3 3 3 3 3 3 ! H
e e e e ta I'm keeping pets
5 5 5 5 5 5 . L.
6 6 6 6 6 6 What are your pets? (multiple selection is
7 7 7 7 7 7 allowed)
8 8 8 8 8 8
o o o o o o A. ) dogs, B.! cats, C.\ birds, D.' fishes
ID Number E. U insects, F.' reptiles, G.' othersmallanimals,
H. U Other large animal, 1.’ Other
Signature

Please fill in the bubbles with a dark color such as black or navy blue. Although a ballpoint pen is acceptable, be
careful because it can not be corrected. A mechanical pencil that is thinner than HB will cause false recognition.

Fig.2-3 An example of a bubble answer sheet
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3. Specifying the position of bubbles

3.1 Reading in the original of answer sheet

Activate AnswerSheetDIY, read the prepared image file of the answer sheet, then create a
document for saving information of the position of bubbles and the attributes of choices.

You can load common image formats available on Mac, that is, PDE JPEG, PNG, GIE, TIFE
etc. Even if the image is in color, it is converted to a monochrome (grayscale) image for use.

When "File » New sheet ..." is selected in the menu, the following panel will be displayed.
Specify the image file here and specify the size of the paper that is used to print it. If the pop-up
menu is not displayed, please push the "Options" button in the lower left.

EO < 6| = m v  mExam?2 3 th Q
— " Exam1 -

(B M BubbleSheets » CE &

0 Downloads old_v01 > Exam3 >

X 0S 2017 > Quiz1 >

- M

B switt Quiz2 » ¥

(PN sample+000.jpg "

£ Doc sample+090.jpg

sample+180.jpg

£33 Library sample+270.jpg ¥

Pictures vo3 > = miniExam2-all.pdf
= FEa - - miniExam2.pdf
WOfk nAFAR > ol |

£ iTunes

A - [ scan 3
5 iCloud Drive o
Devices

Rough Size of Sheets A4 (210 x 297mm) B
Options Cancel

Fig.3-1 Specify the original image of the answer sheet

The image must contain the positioning mark described in 2.1. If the positioning mark can

not be recognized, reading fails. When the positioning mark can be recognized, the original
image of the answer sheet is displayed in the window (Fig.3-2). The recognized positioning
mark is displayed in blue.

® [ ] AnswerSheet.pages
Title - ’
00 2 x | One <] Insert Top New
Style 1,23, .. H .n. Single Regular

Choices

Survey
Fig.3-2 The original image is displayed
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3.2 Saving answer sheet definition file

In the created document, the position of bubbles and the attributes of choices are defined
(see below).

The document can be saved as a file. Select "File » Save ..." on the menu and determine its
name. The extension is sheetdef. Once you create a file, you do not need to specify the image of
the original of a answer sheet when you continue working next time. We also use this
document to read sheet images and to recognize marks.

From now on this type of file is called the sheetdef file.

3.3 Bubbles placed at regular intervals
In this section, we explain how to specify the position of the bubbles that is evenly spaced.
(1) Enter a string indicating the question in the "Title" field

First, enter a string or a number indicating the question in the "Title" field of the window
(see Fig.3-2). The string entered here is used as the header of the output table, so please
make it simple and distinguishable from others. For example, enter "Q1(1)" here.

(2) Choose the style and the type of choices

In the example survey, the first question is a single-select type with five bubbles named A
to E. So select "A, B, C, ..." in "Style" and set the button at the top of the window to
"Single". Pressing the button, the display changes. The styles listed in Table 2-1 are
available. Symbols or numbers corresponding to the selected style are written into the
output table to represent the marks filled in.

(3) Select "regular" for bubbles placed at regular intervals

In this example there are 5 bubbles, and they are arranged at even intervals. So, set the
buttons at the top of the window to "Regular", then enter the number of bubbles to the
field right of the button.
When "Yes, No" or "Yes, No, N / A" is selected as the style, the number of bubbles is fixed
to 2 or 3.

(4) Set the number of questions to One

The pop-up menu to the right of the field is set to "One" here.

B ® AnswerSheet.pages

Title Q1(1) z ’ - —
X One C |

oo ﬁ» <) ancel

l, C. Mailing list,
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vare
(1] AQs c ol e
es are?

Fig.3-3 Bubbles placed at regular intervals (1)

(5) Point the first bubble of the choices

When you press the "New" button, you can specify the position of the choices newly.
Please click the position of the first bubble. As shown in Fig.3-3, a green circle is
displayed. You can adjust the position by moving the mouse during pressing. Once you
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release the mouse button, you can move by dragging the circle. Please adjust so that a
circle appears at the center of the bubble. To cancel the operation press the escape (esc)
key or press the "Cancel" button.

(6) Point the last bubble of the choices

Next, click the last bubble of the choices. Then you can see a figure as shown in Fig.3-4
drawn between the points specified immediately before and the symbols is sequentially
attached to the bubbles. If you hold down the shift key while doing this operation, the
circles drawn will be aligned horizontally or vertically.

You can adjust by dragging the position of the first or the last circle. Hold down the
Command key (38) and drag a circle to move all the circles together.

To cancel the operation, click the "Cancel" button or press the escape (esc) key.

. (o] AnswerSheet.pages
Tile | Q1(1) : 9 00 E—
5 X  One <) Cancel OK
Style A, B,C £ e 3
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Fig.3-4 Bubbles placed at regular intervals (2)

(7) Settle the position of the choices

After specifying the position, click the "OK" button at the top of the window or press the
return key. Then, the figure changes to blue as shown in Fig.3-5, and at the same time,
the item is created in the "Choices" field on the left side of the window. The string of
"Title" is automatically changed to "Q1(2)", and if you continue to work, you can use this
title as it is.

To cancel the whole operation from (1) to (7), use the command key + Z (3Z, or "Edit »
Cancel" of the menu). You can also use "redo" operation.

®© o AnswerSheet.pages
Title Q1(2) : ’
.O 2 X  One B Insert Top New
Style  AB,C,.. B % | Stole | | Regur
Choices g -
n |, C. Mailing list, '
yare (1)| ADg®c®®0c®
ac ara?

Fig.3-5 Bubbles placed at regular intervals (3)

3.4 Selecting an item in the choices field

Settling the position of choices, a corresponding item is newly arranged in the choices field
on the left side of the window. The marks filled in on an answer sheet are read in the order in
which they are arranged, and the data is (basically) also output in the same order.
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When you click on a specific item in the choices field, a red circle flashes at the
corresponding bubble to tell the position. A small yellow square is displayed on the first circle
of the selected set of choices. Conversely, if you click a figure, the corresponding item in the
choices field is selected.

If you specify the position of a new choices with selecting any item in the choices field, the
new item will be inserted after the selected one. If you want to make a new item as the first
one, please check "Insert Top" at the top of the window before the operation.

You can also change the order of items later (see 4.1).

3.5 Bulk specification of sets of choices

By repeating the operation described in 3.3, you can specify the position of the multiple sets
of choices. However, if there are many sets, it will be a hassle because you have to repeat
simple tasks.

If there are two or more choices consisting of the same number of bubbles evenly arranged
and themselves are also evenly arranged, you can specify them all at once. As shown in Fig.

3-6, it is applicable to the case when multiple lines of bubbles are arranged vertically, or where
multiple columns of bubbles are arranged in the horizontal direction.

Q1: Ql Q2 Q3

1 2 3 4 5

1 1 1
QR: 2 2 2
125345 3 3 3
QS 4 4 4
12545 5 5 5

Fig.3-6 Examples of groups of bubbles for bulk specification

Below, for the examples in from Fig.3-3 to 3-5, I will explain how to specify multiple sets of
choices collectively.

(1) Enter a string indicating the question in the "Title" field

Enter a string or a number indicating the question in the "Title" field of the window.
(2) Choose the style and the type of choices

For the first question, select "A, B, C, ..." in "Style" and set the button to "Single".
(3) Select "Regular" for bubbles placed at regular intervals

In this example, 5 bubbles are arranged at even intervals. So, set the buttons at the top of
the window to "Regular”, then enter "5" to the field right of the button.

(4) Select "Bulk" for multiple questions

Select "Bulk" on the pop-up menu to the right of the textfield, then a textfield appears to
the right. Set "3" to the textfield to specify the number of the questions (Fig.3-7).

® @ AnswerSheet.pages
Title Q1(2) : ’

- 00 2 % Buk T : Insert Top New
Style | A,B,C,... B X¢ | Snge || Regulr

Fig.3-7 Select "Bulk" and specify the number of questions
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(5) Specify the position of the first set of choices

Clicking the "New" button, you can specify the position of the first set of choices newly.
Please click the position of the first bubble as described in 3.3. After specifying, click the

"OK" button, or type the Enter-key (Fig.3-8(a)).

D © | [ |
(1) AOE®T®D®E® (1) |FAQEeTe® e ®
(2) AB cl D E (2)2®slcpe
(3) aAl/BlclblE (3)@® s clipl)e
(a) Specify the first choices (b) Specify multiple choices

Fig.3-8 Specify the first choices, then others collectively

(6) Specify the positions of other sets of choices collectively

When you finish specifying the position of the first set of choices, the color of the circle
on the first bubble changes to red. Next, when you click the first bubble of the last set of
choices, a line is drawn from the first to the last sets and you can specify the positions of
the other sets of choices at once (Fig.3-8 (b)). You can adjust the position of the line, too.
If you want to go back to the previous step (position specification by the blue figure),
click the "Cancel" button or type the Escape (esc) key. You can also use command + Z
($8Z, "Edit » Cancel" of the menu).

When the position is decided, click the "OK" button (or type the Enter key) again. At this
point, as shown in Fig.3-9, the positions of the three sets of choices are settled, and the
titles are automatically attached. Even if you specify each at a time, there is no difference
in the result even if you specify multiple positions in batches in this way.

Even when choices are arranged vertically, it is possible to specify the positions by similar
operation. You can also use 3Z to cancel the operation.

® e} AnswerSheet.pages
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Fig.3-9 Bulk specification of sets of choices



3.6 Automatic update of the title string

As mentioned above, when specifying choices, if the title contains numbers the value will be
automatically updated. You can also update the title by hand using the stepper on the right of
the textfield. Automatic updating of the title can be enabled or disabled using the check button
"Automatically increase the number in the title" in the preference panel (see 6.2).

The types of characters in the title that can be updated automatically are limited, and there
are some restrictions.
(1) Arabic numerals

If one or more sequences of Arabic figures are included in the string, only the rightmost
sequence is subject to updating. For example, "Question 1-9" is automatically updated to
"Question 1-10" Also, the number of digits is kept if possible. For example, "Q1 (01)" is
automatically updated to "Q1 (02)".

In addition, the figures in Unicode, from "O" to "9" (U+FF10 ~ U+FF19) are also
recognized as Arabic figures.
(2) Alphabets

If the rightmost alphabet letter is not adjacent to another alphabet or figure, it is subject
to renewal. You can use both uppercase and lowercase letters. For example, "Q1(a)" is
automatically updated to "Q1(b)". Similarly, "Q-A" is automatically updated to "Q-B".
However, "Z" or "z" can not be updated further.

Unicode characters are also available; "A" ~ "Z" (U+FF21 ~ U+FF3A) and "a" ~
"z" (U+FF41 ~ U+FF5A).

(3) Chinese numerals

Although it is seldom needed, you can also use Chinese numerals. For example, "—-t" is
automatically updated to " /\" and "fi] .+ /1" becomes "fi] =+-".
(4) Other Unicode Characters

Currently, the Unicode characters from @ to @) (U+2460 ~ U+2473) and from (1) to ()
(U+2474 ~ U+2487) can be used. However, they can not be updated beyond 20.

3.7 Bubbles placed in free positions

If the bubbles are not evenly spaced, select "Free" with the buttons at the top of the window
and specify the position of each bubble one by one. Below, the choices of Q2(1) in Fig.2-3 is
shown as an example.

(1) Enter a string indicating the question in the "Title" field
Enter a string indicating the question in the textfield "Title". Here, type as "Q2(1)".

(2) Choose the style and the type of choices

Select "0, 1, 2, ..." in "Style"; though alphabets are used as labels, in this case, the style of
numbers will be more convenient for adding up. And, set the button to "Single".

L L AnswerSheet.pages
Tile | Q2(1) - ’
I~ .0 Insert Top New
Style 0,12, .. d # Single Free

Fig.3-10 Select "Free" for bubbles
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(3) Select "Free" for bubbles placed in free positions

In this example, set the button of drawing method to "Free" (Fig.3-10).

(4) Specify the positions of bubbles

When you click the "New" button, you can specify the positions of the bubbles. Clicking
on a bubble allows you to specify its position one after another (Fig.3-11).

(1) Howmmany hours are you watc{%\ing TVadayin av%rage? (online video is excluded)
0 1 2
A. «® 2- 3 hours,
E]
D- ’ -

— 5]
- - - +® More than 6 hours

Fig.3-11 Specify the positions of bubbles

You can move a circle by dragging even if it has been placed once. Mouse operation with
holding down Shift key can align the circle horizontally or vertically to the previous one.
You can also move all circles at the same time by holding down the Command key and
dragging.

To cancel the previous operation, you can use "Undo (3Z)", and "Redo ({+ $Z)" is also
available. To cancel all position setting, type the Escape key (esc) or click the "Cancel"
button at the top of the window.

To settle the position specification, type the Enter key or click the "OK" button.

3.8 Specifying choices that allow multiple selection

In the case of a question that allow multiple marks, set the buttons at the top of the window
to "Multiple", then specify the positions of bubbles. Both "Regular" and "Free" are available to
specify the positions.

For a question that can select multiple choices, there are restrictions on the styles that can
be specified. Only those that have a check in the column "Multiple" in Table 2-1 are available,
that is, numerals, alphabet, katakana.

The case of the example of Q3 in Fig.2-3 is shown. Here, specify "A, B, C, ..." as the style.
Set the buttons to "Multiple" and "Free", then specify the positions of bubbles (Fig.3-12).

® o] AnswerSheet.pages
Title Q3 s 9
n‘ Laa 1 Insert Top New
Style A, B,C, .. u * Multiple Free

Fig.3-12 Specifying multi-select type

o Q3: Please select any number of keywords related tc

00 9 |45

o0 (A)OVR, (B ® AR, (C) ®ioT, (D) ® Program
00 9 006 e ———

o (G) @ smart Phones, (H) @ Robots, () @ Em
LN (K) (S, (L) ® Image Processing, (M) ®vo

Fig.3-13 An Item that allows multiple selection
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In the Choices field, the item is displayed with an icon indicating that multiple answers are
possible (Fig.3-13).

3.9 Specifying a group of choices

There is an answer type which has meaning by combining multiple marks such as date, a
registration number, etc. First, let's explain the case where a group of choices with the same
style are combined, e.g., only numbers.

As an example, consider the bubbles for a student ID number in Fig.2-3. The student ID
number consists of six digits. In such a case, you can specify a group of choices in the same
way as the method of collectively specifying multiple sets of choices (see 3.5).

Basically, the set of choices needs to be arranged at even intervals, but it is possible to make
corrections to their positions afterward (see 4.5).

(1) Enter a string in the textfield "Title"
Enter a string indicating the question in the textfield "Title". Here, type as "ID".
(2) Choose the style and the type of choices

This answer space is a collection of 6 columns of bubbles to answer a single number from
0to 9. So, the style is "0, 1, 2, ...", the buttons are "Single" and "Regular".

(3) Specify the number of the columns of bubbles

In this example, 6 columns of bubbles are arranged at even intervals, and each column
has 10 bubbles. First, enter "10" which is the number of bubbles in each column to the
right of the "Regular" button. Next, select "Group" from the popup menu and enter "6" as
the number of columns to the right of it (Fig.3-14).

[ NN ) [ AnswerSheet.sheetdef
Title D : ’

00 ol x crowp | EI - Insert Top New
Style 0,12 .. H .n. single regular

[%]3-14 Setting for a group of choices

(4) Specify the position of the group of choices

Next, click the "New" button and specify the bubbles of the first column as in the
explanation of 3.3. Click the "OK" button (or type the Enter key) to finish (Fig.3-15(a)).

— 2—8—4}—{5}—6}—
01 Q o 0 0 0 0 0 o< @& @ ®o@®o 0 0 0 0 0 0
1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
2/ @) 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2
B3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3 3
AP 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4
0N 2 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5 5
X 2 6 6 6 6 6 6 6 6 6 6 6 6 6 6 6 6 6
71 @7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7 7
]aj 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8 8
D@9 9 9 9 9 9 9 9 9 9 9 9 9 9 9 9 9 9
(a) (b) (c)

Fig.3-15 Specify the position of the group of choices
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When you settle the position of the first column, the color of the circle on the first
bubble changes to red. Next, when you click the last column, a new line is drawn
between the position clicked and the first column, and the positions of the columns
located between them can be specified (Fig.3-15(b)). Again, click the "OK" button (or
type the Enter key) to finish (Fig.3-15(c)).

As in the explanation of 3.5, if you want to go back to the previous step, click the

"Cancel" button or type the Escape (esc) key. You can also use the operations "undo" and
"redo" (88Z and 0+ 38Z).

Even when bubbles are arranged side by side, it is possible to specify the position of the
group by the same operation.

By the way, in the group format, it is assumed that each set of choices is single-select type.
Although it is possible to make a group with multi-select types, it is doubtful whether there is
an appropriate use purpose.

3.10 Importing an existing sheeted file

When making a new document, if possible, it is helpful to use the information of the already
existing sheetdef file. By selecting "File » Import other file..." on the menu, you can read the
information of choices saved in other sheetdef file.

At this time, coordinate transformation is performed to place over the positioning marks of
the imported file on the positioning marks of the current file. This transformation is also
applied to the positions of all the choices (Fig.3-16). Therefore, documents with the
positioning marks at the exactly same points they can use the position information as it is. But
if not, the position information needs to be corrected after import.

[ | [ |
o 000 Coordinate
Existing transformation
sheetdef File 000
u u Import
H = m =
Current o—0—0
Document -
o—0—-0
[ | [ | [ | [ |

Fig.3-16 Import an existing sheeted file



4. Edit the position and information of choices
4.1 Edit the order of items

Items in the Choices field can be moved by dragging with the mouse. This allows you to
change the order of data elements in the output (Fig.4-1(a)).

Multiple items can be selected at once using shift click or command click. It is also possible
to drag multiple items simultaneously (Fig.4-1(b)). The result of the operation can be canceled
with 3Z.

Q1(1)
Q1(2) i 00 9 AB..E
Q201 00 |9 AB..E 0 » @@
01,..6 00 9 AB..E
00 "u..(s’)' LY
Q1(3)
AB,...E
$01s A 00 9 AB.E
Q3
a2 () 3E }A,%?.('!N
00 9 0.6 00 9 o01.6
Q3 Q3
@ 9 AB.N
ID
(a) Move an item (b) Move selected 2 items

Fig.4-1 Moving of items in the Choices field

4.2 Cut, copy, and paste of items
You can apply cut (#X), copy (3£C), paste (3#V), and duplicate (38D) operations to
selected items in the Choices field. Also, you can use undo (#Z) and redo ({} 3Z) operations.

WV [ 7  ADPE

A.

Edit
Move
| B Cut #X c.
Copy #C
Q2(1) P sV E (1) ACs@ O @
.O 9 o Duplicate #D .
‘! Delete
Q3 Undo ¥Z 3 PIG (2) A
o,A,I Redo esezcor 3 Y > X DY 53
Special... [ 3
ID Rename
Renumber HOV
00 9 04 - A
Fig.4-2 Context Menu Fig.4-3 Duplication of choices



These operations can be specified from the keyboard, or can be specified by the context
menu, which you can show by right-clicking or by control-clicking in the Choices field (Fig.
4-2).

There are delete in the applicable operations. This removes the selected choices and leaves
no information on the pasteboard.

Copy and paste, or duplicate, then you can create items with the same title, style, and
choices. The duplicated choices are displayed in light orange color beside the original choices
(Fig.4-3). This can be dragged with the mouse, so, move it to the appropriate position and click
the "OK" button at the top of the window or type the Enter key. If you want to cancel the
operation in the middle, click the "Cancel" button or type the Escape key.

You can paste or duplicate multiple items, not just one item.

The duplicated items has the same title as the original, so change it if necessary as described
in the next section 4.3.

4.3 Renaming

To change the title of items, display the context menu in the Choices field as shown in Fig.
4-2 and select "Rename". Then you can type new name as shown in Fig.4-4.

Note that the change will not be reflected unless you type the Enter key at the end of the
input.

00 9 o01.6
2 N (2)Ar

05 | o

Q3
Fig.4-4 Rename a title

Instead of directly entering titles, you can also assign a sequence of numbers to multiple
items in a certain range. The sequential numbering here is to assign titles with the numbers
and alphabets incremented one by one as described in 3.6. For this purpose, the following

conditions must be satisfied.

* Jtems to be renamed must be one or more and must be continuous.

* Immediately before the selected range, there must be an item with appropriate title as
the starting point.

* It is impossible to assign titles beyond the maximum number, e.g., "Z" of alphabet.

Select the range to be numbered consecutively, and select "Renumber" from the context
menu. An example is shown in Fig.4-5.



@ 9 AB..N @ 9 AB.N

Q4(1) Q4

00 9 12.5 00 9 12.5
Q4.1 Q4(2)

00 » 12.5 00 9 12.5

—

Q5 Q4(3)

00 » 12.5 00 9 12.5
Q5.3 Q4(4)

00 » 12.5 00 » 12.5
Q5 Q5

Fig.4-5 Renumbering items

4.4 Moving the positions of choices

It is possible to move the positions of choices. Right-clicking (or control-clicking) on the
Choices field or on the view (drawing area) of the answer sheet to display the context menu as
shown in Fig.4-2.

When "Move" in the context menu is selected, the choices selected at that time are displayed
in light orange color, and they can be moved by dragging (Fig.4-6). Holding down the Shift key
during the mouse operation, you can limit the movement to vertical or horizontal direction.

(2)| ABsl c bl E
)
Fig.4-6 Moveing choices

To finish the operation, click the "OK" button at the top of the window or type the Enter key.
To cancel the operation, click the "Cancel" button or type the Escape key.
To adjust the position of each individual circle of choices, follow the procedure in 4.5.

4.5 Adjusting the positions of bubbles

You can individually adjust the positions of a bubble that are included in a set of choices.
First, I will explain how to modify a choice that is not a part of grouped sets of choices. That
is, its set of choices was specified individually or specified collectively by bulk mode.

4.5.1 Choices specified individually or in bulk

Double-click an item on the Choices field or a circle on the view that displays the answer
sheet, then the color of the circles changes into red (Fig.4-7(a)). Now, you can apply any
operations below.

(1) Adjust the position of a circle

You can move any red circle by dragging (Fig.4-7(b)).
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(2) Add a new circle

Click any point that is not on red circles, then a new circle appears at the point (Fig.
4-7(c)).

(3) Delete a circle

Type the Delete key, then the last circle is removed (Fig.4-7(d)).
(4) Move all circles

Hold down the Command key and drag any red circle to move all the circles.
(5) Reverse the associated numbers

You can display the context menu (Fig.4-7(e)) with right-click or control-click. If you
select "Reverse", the numbers or symbols attached to the circles can be rearranged in
reverse order.

mTEeEE || | @ @66 mEEmE

O0-0-0-0-0
(1)| AOs®c®s®¢ (1) ACe 2L®5®¢ (1) ACs®c®p®e®g
(a) Edit mode (b) Move a circle (c) Add a new circle

. _. Undo %Z |

M2 E @ fedo %25 @ @ [

O0-0-0-90 Delete Last <@
(1) AO5®c®s®¢ Ceete Last - ABB5OE@

I

(d) Remove the last circle (e) The context menu

Fig.4-7 Editing circles

To settle the change, click the "OK" button at the top of the window or type the Enter key.
To cancel the operation click the "Cancel" button or type the Escape key. You can also undo
(38Z) and redo ({+ 7Z) in the middle of the operations.

These operations can be applied irrespective of whether "Regular” or "Free" arrangement was
used when the choices were located first. In other words, "Regular" arrangement is merely a
convenient way to easily specify the positions of choices.
4.5.2 Choices included in a group

When handling multiple sets of bubbles as a group (see 3.9), each set must have the same
number of circles. Therefore, you can not add or delete circles.

On the view of the answer sheet, double click the circle you want to edit. Then, the set of
circles become editable state as shown in Fig.4-8(a).

In this state, it is possible to adjust the position of a certain circle, move the whole circles,
and reverse the order of the labels (Fig.4-8(b)). Hold down the Command key while dragging
to move the whole circles (Fig.4-8(c)). Reverse operation has an effect on all sets in the group
together.
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(a) Edit mode (b) Move a circle (c) Move a set

Fig.4-8 Edit circles in a group

5. Special settings

5.1 Joining the data of an item and its following together

As described in 3.9, sets of choices can be treated as a group. However, with this method, all
sets in a group must have the same style and have the same number of choices.

Consider the example in Fig.5-1(a). Here, the class names are from A to E, and the
attendance number of each class is limited to 40 at most. Assume that you want to obtain
student class and number as string data like "A32", "E08".

A BCODE
Class @_O@_Q_O StudentiD
01 2 3 4
o 66884 00 F3 »s..6
012 3 4567 8 9
00 01,...4
Class No.
Name: .O 9 01.9
(a) Choices in different styles (b) Joining items together

Fig.5-1 Joining the data of items

First, specify choices in each answer column as shown in Fig.5-1(a). Next, as shown in Fig.
5-1(b), in the Choice field, click the first two " , " buttons to be "+".

This setting does not output "," or tab characters, which are delimiters between the next
data item when outputting data, and it generates combined data. In this example, don't change

the status of the third item to "+"not to be combined with the following data.
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5.2 Stop the processing depending on the existence of a certain mark
You can set a special attribute to a certain set of choices. Depending on whether the choices
are marked or not, the process of reading a sheet stops. With this attribute, you can specify not
to read all marks following. For example, it can be used in cases like Q4 in Fig.2-4.
Display the context menu in the Choice field and specify either "Stop if Marked" or "Stop if
Not Marked" (Fig.5-2). If you do not specify neither, select "None".

ww 7 ey

na-Those who keeping pets, please

Qaflag Edit
Move
05 v | Mo ., Jubble.
Qa Copy #C
Paste ®V ! 1
O lae] o o0 I'm keeping pets ©
Delete
Undo xz hat are your pets? (multiple sele
r\\uorl\
Special... » None
Rename Stop If Marked
EETITIIT 5t C. @ birds—
Reumber ATV 5t5,—C. 9 hirds;

Fig.5-2 Setting of the special attribute



6. Recognition of answer sheets

6.1 Scanning answer sheets with an image scanner

Scan the filled in answer sheets using your image scanner and save them as image files. The
scanner should be equipped with a paper feed mechanism (auto feeder) that automatically
loads sheets one by one.

(1) Making ready for scanning

For scanning, 200 dpi resolution is recommended. After all, since marks are filled in by
human, resolution higher than 300 dpi has no meaning, on the contrary it causes an increase in
file size and a decrease in processing speed. However, if the resolution is too coarse, the
recognition accuracy of the marks will be poor.

Scan sheets in grayscale (monochrome). AnswerSheetDIY can process color images, but
color information is useless because they are converted to grayscale during preprocessing. An
example of grayscale image is Fig.6-1(B).

(A) Color (B) Grayscale (C) Bilevel (D) Dithered bilevel

fair suitable wrong wrong

Fig.6-1 Classification of images

(2) File formats of images

The formats of image files to be saved can be JPEG, PDF, PNG, GIE TIFE and other normal
formats that macOS can handle. From the viewpoint of reducing the file size, JPEG or PDF is
good.

If JPEG compression rate is too high, noise will be seen in the image, but the compression
ratio normally used wouldn't be in trouble. There is no affect as long as you do not notice it by
eye.

PDF can be either one file by the sheet or a file with multiple pages.

If there are multiple image files, save them in one directory. If so, AnswerSheetDIY can easily
read them at once.

(3) Direction of images to be recognized

AnswerSheetDIY recognizes the positioning marks and automatically rotates each sheet
image in the correct direction. Therefore, you can scan answer sheets in any direction.
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6.2 Settings for reading sheet images

It may be better to change the setting such as the thickness of the marks depending on how
bright (or dark) the answer sheets are being read by the scanner. This setting is done with the
Preferences panel ("AnswerSheetDIY » Preferences..." on the menu) (Fig.6-2).

Preferences

Threshold of
Positioning Marks © - - -

Threshold of Bubbles - ' (o)
Resolution of scanned images 200 dpi (200 is recommended)
Width of noise ignored at the edge 50 pixels
Output Format of Multiple-Selection 110010010001 E
Use quotations ("...") in output

Automatically increase the number in the title

Cancel | (SEECCIN

Fig.6-2 Preferences panel

The "Threshold of Positioning Marks" specifies the level of black that the positioning marks
must be darker than this. Since positioning marks are printed on paper, they should normally
be considerably darker than writing tools such as pencils.

The "Threshold of Bubbles" specifies the level of black that only bubbles darker than this can
be recognized as marks. If you specify a dark color, you can reduce misrecognition, but you can
not read thin marks. Conversely, if you specify a light color, you will be able to read thin marks
as well, but the number of misrecognition will increase.

In the choice types, multi-select type is affected by this setting. On the other hand, single-
select type adopts the darkest mark position among the choices, so it is not affected much by
this setting.

"Resolution of scanned images" specifies the resolution of the scanner when scanning the
sheets.

"Width of noise ignored at the edge" is a setting to ignore the part of the paper scanned by
the scanner where the stripe or blackening occurs at the edge of the paper. The initial value is
50 pixels, but it may be necessary to change the setting depending on the scanner to be used. If
resolution is 200 dpi, 50 pixels is about 6.3 mm (1/4 inch). If this value is made too large,
reading of positioning marks may be affected.



6.3 Recognize marks on images of answer sheets
(1) Load the sheetdef file
Read the sheetdef file that specifies the positions of bubbles on the sheet to be processed
and display it.
(2) Open the Recognition window

Select "File » Read out marks..." on the menu, or type 3$R. Then the Recognition window
is displayed (Fig.6-2).

00 Recognition: AnswerSheet
Include "source" field in output Show images of answer sheets ﬁ
Output with the Header
Copy & Paste with TAB as separator I—gl Scan Files...
source ID Q1(1) Q1(2) Q1(3) Q2(1) Q3 Qaflag Q4

Fig.6-2 Recognition window

However, at this time, it is necessary that all items have different titles (excluding those
joined to the previous one. See 5.1). If there is an item without title or an item with the
same title as other, a panel as in Fig.6-3 is displayed. If you click "YES" here, you can
automatically assign titles like Q_1 and Q_2, but it is better to manually add titles
according to the contents of the questions.

@ov */  Make Unique IDs Automatically?
There are items without ID, or items with the same ID.
-

| Cancel | (SIS
Fig.6-3 Warn if items don’t have unique IDs

(3) Specify image files and read out marks

There is also a method of proceeding while displaying the image of the answer sheets,
but first of all, here a method is explained which simply performs recognition only.
Uncheck the button "Show images of answer sheets" on the window.

Next, click the "Scan files..." button. The Open panel is displayed, so specify the directory
where the read image file is stored and click the "Open" button. You can also select and
open one or more files, not directories.

When you specify files, reading begins and results are displayed in the window. The
processing status can be checked with the progress bar (Fig.6-4).

If there is no error, it exits without any messages. If you want to interrupt the processing,
click "Cancel".
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Fig.6-4 Recognition is in progress

(4) Read additional files

After the process, you can click on the "Scan files..." button again to specify another
image file and read it. The result is added to the end of the current data list.

6.4 Recognize marks while displaying images

In the previous section, it was only to process the image files simply, but you can go on the
process while displaying each sheet and the recognized marks. To do this, put a check in "Show
images of answer sheets" in the Recognition window (Fig. 6-2).

Also, clicking on the gear icon on the right of this check button displays a popover
(balloon), in which you can specify in detail (Fig.6-5). To close the popover, click on the icon
again.

If "Confirm each sheet" is checked, for each sheet its image and recognized marks are
displayed, and then click the confirmation button to proceed to the next. If you do not check
the button, the loaded images will be displayed one after another automatically.

If you check "Display the entire sheet", each image will be reduced to the size that the whole
of it can be displayed on the screen.

If "Warn of unrecognized sheet" is checked, when the recognition of the positioning marks
fails a warning will displayed.

If "Warn about too few marks" is checked, a warning message points out the possibility that
the image being read does not match the sheetdef file. Specifically, it is the case that the
number of recognized marks is less than 1/5 of the number of questions.

Show images of answer sheets
ni ] Confirm each sheet
Display the entire sheet ﬁ
- Warn of unrecognized sheet

Warn about too few marks

Fig.6-5 Options for displaying

An example of the window displayed is shown in Fig.6-6.

Blue circles are displayed at the positions to be read, and red check marks are displayed at
the position where the marks were recognized.

You can adjust the size of the displayed image with the button at the top left of the window.
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In order to go to the next image, click the "Next" button at the upper right of the window.
"Skip all" stops viewing one by one, and automatically displays after that. "Cancel" will stop
reading images.

00 @ scan_055.jpg
NG Cancel [ OK |
o . REN
P‘_&)‘c_ﬁ'):b@‘i@bo ﬁo BO CO D\v/ EO
54759 a—,
5 I_ REN
iA@ 80 cQ 00 €0

Fig.6-6 Display of recognized marks

6.5 Confirmation and modification of data

You can display again an answer sheet that was read once, and you can also read out marks
again. In addition, it is possible to delete a line of data, and to correct read errors, mark errors,
etc. individually. However, since these are aimed at small scale modifications, use spreadsheets,
editors, etc for changes and processing across the data.

In the Recognition window, you can display the context menu by right-clicking or control-
clicking with one or more lines selected. Alternatively, you can display the context menu by
clicking the button under the progress bar (Fig.6-7).

E Scan Files...
—  Show Image

Q4 Q5 Scan Again Q@ Q10

IaY o [ =]

B A Delete C E
BN Cected' PEENCEE

A 8 Undo 28z E C

E A C E

A Cc ~ ~ ~ Cc E

Cc C A D c B E

Fig.6-7 Context menu of the Recognition window

(1) Show the image of an answer sheet

When you click "Show Image" on the context menu, the image of the answer sheet
corresponding to the selected data is displayed again as in Fig.6-6, and at the same time
the mark is recognized too. When multiple lines are selected, images are displayed one
after another accordance with the setting for display (Fig.6-5).

(2) Read out marks again

If you click "Scan again" on the context menu, AnswerSheetDIY loads the image
corresponding to the selected line and recognizes marks, then updates the data on the
line.



Basically, the same result will be obtained for the same file, but the different result may
be gained by changing the mark thickness setting explained in 6.2.

(3) Delete selected lines

Click "Delete" on the context menu to delete the selected data lines. You can use it if the
same answer sheet was read more than once or if the wrong image was specified.
"Delete All" deletes all data, including unselected lines.

(4) Modify a data item

Double-click the data item to edit its contents (Fig.6-8). It can respond to omissions of
required items and obvious failing marks.
In addition, you can also use "Undo" (38Z) and "Redo" ({+ 3Z) for correction.

|scan_030jpg 5440 011 B cC B
[ scan_031.jpg 5442 101 D £ A
i scan 0321pg 5443 001

scan_033pg _|EETY mm-_u

{ scan 034 ipg 5444 100

Fig.6-8 Modification of a data item

6.6 Save the obtained data

In order to save the obtained data, with displaying the Recognition window in the front,
select "File » Save..." from the menu or type 3S. As the file format, CSV or TSV can be
specified on the save panel (Fig. 6-9). The extensions are csv and tsv respectively. These data

formats are explained in Chapter 7.

Recognition: miniExam1

iin ol gave As: miniExaml.csv v ) Es®
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Tags:
\B as f

Where: | scan
| 8
Z1o O CSV (Comma-Separated Values) '
818
764 |
666

629 7 7 Cance ) .

Fig.6-9 Save the obtained data
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TSV (TAB-Separated Values)

You can select part (or all) of the data displayed in the window on a line-by-line basis and
copy it to the pasteboard.

Whether you save the data to a file or copy it to the pasteboard, the format of the data is
altered by selecting the check buttons on the Recognition window (Fig.6-4).

"Include source field in output" specifies that each record (line) should include the name of
image file. It is convenient when you want to compare data and the answer sheet later.

(1) Include "source" field in output



This specifies that each record (line) should include the name of image file. It is
convenient when you want to compare data and the answer sheet later.

(2) Output with the Header
This specifies that the title of each column should be included as the first line of data.

(3) Copy & Paste with TAB as separator

This specifies that TAB is used as the data delimiter (TSV format). If not checked, comma

is used (CSV format). The selection of this button has no effect when saving data to a
file.

For example, suppose you have read some answer sheets, select the first two lines (that is,
two sheets), perform the copy operation, and paste it in an editor or the like. If all of the above
check buttons are checked, the following text data will be pasted. Blanks are tab characters.

source ID PTN Q1 Q2 Q3 Q4 Q5 06 Q7 Q8
scan@0l.jpg A48592 100 E E
scan@02.jpg A41084 101 C F D C E A D C

s}
m
(@]
s}
o
p

If you copy and paste the same data after removing all three checks, it becomes as follows.

A48592,100,E,E,B,E
A41084,101,C,F,D,C,

For your information, pasted data can be retrieved with the command pbpaste. So if you
copy part of the data and then enter the command with Terminal.app as follows, then in this
case you can get the file "data.txt" ($ is the prompt).

$ pbpaste > data.txt




7. Data formats
7.1 CSV and TSV

The data generated from answer sheets can be saved in a file in either CSV or TSV format.
Both use UTF-8 for character codes.

CSV format (Comma-Separated Values):
This format uses comma "," as data delimiter. It is often used to exchange data of
spreadsheet, database, or many popular applications.

TSV format (Tab-Separated Values):

This format uses a tab character for delimiting data.

Both formats can be used with Excel, Numbers, etc. Applications of macOS allow you to
copy and paste spreadsheet data into a tab delimited data format that is the same as TSV
format, so it can be said that affinity is high.

If the data item itself does not contain a comma, you can convert the format with
Terminal.app of Mac as below ($ is the prompt).

CSV — TSV

$ tr ',"' '\t' < source.csv > target.tsv

TSV — CSV

$ tr "\t' ',' < source.tsv > target.csv

7.2 Data corresponding to single-select type

For a question of single-select type, if there is a mark, basically only one data is written into
the output, and if there is no mark it is treated as blank. For example, in the example of the
CSV format (comma separated) below, the data on the second line indicates that there were no
marks at the last three items.

In addition, when multiple places are marked for a single-select type question, the darker

A48592,100,E,E,B,E,C,B,D,A
A41088,110,C,F,D,C,E

rr

(blacker) mark is chosen, but if there are multiple marks of the same degree of blackness,
nothing is selected. It is treated the same as blank, that is. Be careful when deciding the answer
method of the question.



7.3 Data corresponding to multi-select type

For a question of multiple-select type, data that enumerates recognized marks is written
into output.

There are several ways to represent multiple answers as data. Clicking the gear icon of the
document window displays a popover (balloon) and you can select a format (Fig.7-1). This
setting is saved in the sheetdef file.

— 12,5,.8,.12
L 11,4
Output Format o 11.0,0.1,0,01,0,0,0,1 >
00
110010010001 .ﬁ Single
Save as Default Cancel [ OK 'Iease sele
00 9 01.9 correspont
i (1) How many

Fig.7-1 Set a format for multi-select type

A similar popup menu also exists in the preference panel. It is for setting the default value
of the format.

This menu shows several representation patterns of multiple marks. All of them represent
that in the range of 1 to 12, the 1st, 2nd, 5th, 8th and 12th choices are selected (Table 7-1).

Table 7-1 Representation patterns for multi-select type

Pattern Comment

Place a comma (or tab) between all the items and place
@ 1,2,,,5,,,8,,,,12 figures only on the marked choices. If the style is "A, B,
C ..." then alphabets are placed, not figures.

®1,1,,,1,,,1,,,,1 Same as above but place "1" on the marked choices.
® 1,1,0,0,1,0,0,1,0,0,0,1 Place "1"as above, and place "0" for not marked choices.

Arrange "1" and "0" indicating the presence or absence

@ 110010010001
of marks.

® 110010010001 Arrange"l"and"0"as above, seperating with spaces.

In the table, the delimiter is indicated by a comma. The actual delimiter is comma in CSV
format, tab in TSV format. For example, assume that Q1 and Q3 are single-select types, Q2 is
multiple-select type with four choices. If you create output data with patterns @ and @ in
Table 7-1, they are as follows (CSV format).
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Output with @ Output with @

Q1,Q2,,,,Q03 01,Q02,Q03
E,A,,,D,2 E,1001,2
B,A,B,,,2 B,1100,2

As in this example, with the patterns (D, @), @ which use delimiters, delimiter characters
are placed in the header part corresponding to the number of choices.

7.4 Tips for tabulation

Since AnswerSheetDIY does not support totalizing or tabulation, it is necessary to read the
obtained data into spreadsheet software or to make some kind of program to process it.

Here is an example of processing data using the script language AWK. AWK is a language
that has a long history and that is standard in UNIX operating systems. It is specialized to
process text data, ant its grammar is relatively simple. AWK of macOS can handle text in
UTEF-8, but only simple string operations (comparison or concatenation) are available.

First of all, each record of the sample data contains the file name, student number,
marks from Q1 to Q5 (single-selection) as a result of a quiz. This is saved in the file
"result.tsv" in TSV format (Fig.7-2).

img001. jpg 18002 A D C D
img@02. jpg 18001 A A D D
img@03. jpg 18009 A E D C D
img@04. jpg 18008 B D C B
img@05. jpg 8004 A D C D B
img006. jpg 18006 A D B D B
img@07.jpg 18007 A E D C

Fig.7-2 result.tsv

On the other hand, suppose that you prepare a list of class student numbers in the file
"list.txt" and a correct answer for the quiz in the file "answer.txt" (Fig.7-3, Fig.7-4).

18001
18002
18003
18004
18006
18007
18008
18009
18010

Do N o m>

Fig.7-3 list.txt Fig.7-4 answer.txt

Here is a script "mark.awk" in AWK.
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BEGIN { # Setting before the main loop

FS = "\t" # Set delimiter for TSV (","™ if CSV)
while ((getline < "list.txt") > 0) {

name[$1] = "@" # 1st elem. as the index of array
+

while ((getline < "answer.txt") > 0) {
ans[++n] = $1 # Save 1st elem. in array of answers

} # initial value of 'n' if 0.
}
{
if ( "X" name[$2] == "X" ) { # $2 is no included in 1list.txt
printf("%s\twrong student number (%s)\n", $2, $1)
telse {
name[$2] = "1" # we have already seen student of $2
}
m=20 # The number of correct answers
x =1 # Used as the index of ans][]
for (i = 3; i <= NF; i++) { # NF = number of fields
if ( $1 == ans[x] ) m++
X++
}
printf("ss\t%sd\n", $2, m) # Print student & count
¥

END { # Output after the main loop
for ( w in name ) {
if ( namel[w] == "0" ) { # no data for student of "w"
printf("%ss\tAbsence\n", w)

b

Fig.7-5 mark.awk

For each record, it counts the number of correct answers, and check whether student
number is right. In addition, it checks whether there are students who have not submitted
answer sheet (Fig. 7-5).

This script can be run on the terminal as follows. Here, command "sort" sorts the obtained
results in ascending order on a line-by-line basis.

$ awk -f mark.awk < result.tsv | sort
18001 2

18002 3

18003 Absence

18004 Absence

18006 2
18007 4
18008 3
18009 4
18010 X%
8004 2

8004 wrong student number (img@®5.jpg)
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Even if you want to conduct another quiz, you can reuse this script simply by changing the
correct answer file, if the 1st and 2nd elements are a filename and a student number and the
others are answers for questions of single-selection type. Moreover, since the delimiter is tab,
you can copy the output result and paste it into spreadsheet software.

8. Miscellaneous notes

8.1 Practical problems

Use AnswerSheetDIY at your own risk. Applications are just tools. Don't sacrifice accuracy
and reliability for labor saving. Please pay attention to the following points when you use
AnswerSheetDIY.

(1) Some measures to multi-feed

The most frequent troubles with scanners that has auto feeder are "multi-feed", that is,
an error by feeding multiple sheets at once. By this failure, some sheets are skipped and
missed reading.

To alleviate this problem, you need to pay attention to the following points.

* Let's count the number of sheets to be read before scanning and confirm that it
matches the number of images made by scanning. It is recommended to make the
number of sheets to be scanned at once a fixed number, such as 10 or 20. Proceeding
in this way is helpful to find and recover multi-feeding.

* The rough (probably inexpensive) paper tends to cause multi-feeding, so you should
use printer paper or copy paper at least.

(2) Scanner read error

AnswerSheetDIY recognizes marks by correcting even the image which is read slightly
inclined. There is no problem even if the direction of the paper is rotated by 90 ° or 180 °.
However, it is impossible to recognize marks such as extremely inclined images, partially
missing images, blurred images, images containing noise (dirt), etc.

Sometimes check the images made by the scanner and check if the image is not tilted or
dirty.

Scanning a lot of pencil-marked sheets, the paper feed rollers will become dirty and the
gripping force will decrease. Also, eraser dust often adheres to the sheet, which may stick
to the sensor section of the scanner. Sometimes it will be necessary to clean the interior
of the scanner.

(3) Improve reliability by reading multiple times
It is difficult to confirm that many answer sheets have been scanned correctly. Therefore,
the method to scan sheets multiple times and to check mutually the results will improve
reliability.
Although it may take some effort, it is worth considering when dealing with important
information.

(4) Recognition of thin marks

Even if being cautioned to fill in bubbles with a pencil of HB, people who mark with 2H's
mechanical pencil etc. may exist. Such a sheet can be checked to some extent, for
example, whether the student number is correctly marked in an exam, if the number of
marks is extremely small, etc. Of course, you have an option to ignore them.
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In addition, a mark which was strongly filled with pencil and then erased and a mark
filled with 2H's pencil may have similar blackness, and it is difficult to fully determine
automatically.

8.2 For your information
(1) Image Scanners
The author of AnswerSheetDIY uses Canon's compact scanner imageFORMULA DR-150 to
read answer sheets. This product is an old product which has not been sold already (there are
successor models). Although it is inexpensive, it is very reliable, and there is no problem in
scanning answer sheets. Because it is compact and requires no external power supply, it can
also be carried with a personal computer. However, you can only read up to 20 images at a time
and scanning is not so fast. If you are going to read a large amount of data frequently, you may
need to select a model that has a multi-feed checking function and has a high scanning speed.
In addition, Canon and Epson's laser complex machines are used for scanning too, but there
are not particular problems. If it is a scanner that can read grayscale images with a resolution of
200 dpi or higher, there is no problem in use.

(2) How to make the original of answer sheet

Word processors (Pages, Word, and etc.) can be used, but you will struggle with the
layout of answer columns.

KeyNote and PowerPoint, which are applications for presentation, are recommended
as free layout is possible. The standard page layout is landscape, but you can also set it
to portrait paper by specifying custom size.

You can also use the graphics drawing applications. For example, Adobe Illustrator
and OmniGraffle. However, things rich in functions are somewhat expensive.

In any case, there is no problem as long as the original can be get in PDF or JPEG
format. You can even write it by hand if you do not mind the effort.

(3) Recognition rate

It is extremely difficult to explain "recognition rate" of AnswerSheetDIY.

In the case of a dedicated machine for answer sheet processing, "recognition rate" can be
obtained from the actual operation record based on the assumed usage. On the other hand, you
can use AnswerSheetDIY for any purpose, with any scanner and with customized answer
sheets. How correctly the scanning is performed depends on these factors considerably.
Therefore, it is difficult to think about comparable "recognition rate" itself.

(4) Numbering to bubbles

If you actually collect data with answer sheets, you will find that marking errors are
overwhelmingly larger than mechanical or software misrecognition. Therefore, it is necessary
to make answer sheets so as not to mistake the position of the mark as much as possible.

You should write a figure or a symbol such as 'A', 'B' etc. immediately next to each bubble.
See the example in Fig.2-3. In the space for the student ID number, every bubble has a figure
placed next to it. It is important to reduce the possibility of mistaken marking with bubbles in
such style.

Never place such symbols and figures in bubbles. Since AnswerSheetDIY recognizes a mark
with darkness of the scanned image, if you plane a letter in a bubble, there is a possibility of
misrecognition.
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(5) Shape for the frame of a mark

Up to this point, an oval are used as the frame for a mark in many cases in this document.
Actually, a mark is recognized as a small circle range, so there are no problems using a circle or
a square as a bubble. However, in the case of using a square (even in the case of a circle), many
people will misunderstand that a check mark (/) should be put. Similarly, if you use a
rectangle or brackets like [ ], some people fill out only one straight line.

The oval shape has the effect of implicitly instructing to "fill the inside".

(6) A logo attached by a copying machine

Some of copying machines that can be used in companies and schools may be set that a logo
of the organization is printed on a corner of a sheet. If the area of the painted part of the logo is
relatively large, there is a possibility that the positioning marks can not be recognized correctly.

However, AnswerSheetDIY can cope with such cases to some extent, since the positioning
marks are designed to be set relatively large. Fig.8-1 is an actual answer sheet that a logo mark
is printed. In this example, letters are printed in the lower left. No misrecognition has occurred
with this logo mark.

Please check whether AnswerSheetDIY can recognize positioning marks succesfully in your
environment, since operation can not be guaranteed for all cases.
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8.3 Copyright

Copyrights of AnswerSheetDIY and this document belongs to the author Takeshi OGIHARA.

AnswerSheetDIY can be used free of charge. There are no restrictions on its purpose of use.
However, even if some disadvantage arises to the user by using this software, the author will
not assume any responsibility for it.

Takeshi OGIHARA © 2018



Usage of AnswerSheetDIY

Overview
1.1 What is AnswerSheetDIY ?

1.2 What AnswerSheetDIY supports?
Formats of answer sheets
2.1 The size of sheet and the positioning marks
2.2 Bubbles for choices
2.3 Kinds of choices
2.4 An example of an answer sheet
Specifying the position of bubbles
3.1 Reading in the original of answer sheet
3.2 Saving answer sheet definition file
3.3 Bubbles placed at regular intervals
3.4 Selecting an item in the choices field
3.5 Bulk specification of sets of choices
3.6 Automatic update of the title string
3.7 Bubbles placed in free positions
3.8 Specifying choices that allow multiple selection
3.9 Specifying a group of choices
3.10 Importing an existing sheeted file
Edit the position and information of choices
4.1 Edit the order of items
4.2 Cut, copy, and paste of items
4.3 Renaming
4.4 Moving the positions of choices
4.5 Adjusting the positions of bubbles
4.5.1 Choices specified individually or in bulk
4.5.2 Choices included in a group
Special settings
5.1 Joining the data of an item and its following together
5.2 Stop the processing depending on the existence of a certain mark
Recognition of answer sheets
6.1 Scanning answer sheets with an image scanner
6.2 Settings for reading sheet images
6.3 Recognize marks on images of answer sheets
6.4 Recognize marks while displaying images
6.5 Confirmation and modification of data

6.6 Save the obtained data
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